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* USER MANUAL FOR NETWORKS ~

1. ABOUT THE URBACT WEBSITE

The URBACT website is the programme’s main communication tool. The website receives 25 000 to 40 000
unique visitors a maonth, making it a powerful platform for the exposure of your network. More generally the
website allows raising awareness about URBACT and its work, adding value to URBACT cities’ work and
engaging with others involved in these fields, promotfing learning and good practice transfer.

The website has a diverse audience (such as Monitoring Committee members, EC officials, urban
practitioners, city officials, academics, NGO officials, citizens, various stakeholders and various other
professions and entities) that are seeking interesting policy practices on specific topics, results of networks,
networking activities based on events posted, efc.
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Since not all these individuals are familiar with URBACT it is important that the contents featured be
conceived for a non-URBACT audience as well. In priority practitioners are looking for clear,
concrete, practical and synthetic information.

1.1. How does the URBACT website work?

There are three kinds of contents on the website:

- static pages, which relate to the programme, its open calls etc., as well as editorialized contents:
articles written by Programme Experts, Lead Experts or members of the Secretariat, which are all
managed by the Secretariat (homepage, About URBACT section and News & Events section)

- network pages, managed by networks (Networks section)
All these contents feed the 5 themes and related topics pages (Urban Topics section), as well as
country pages in English and city pages.

- National URBACT Points (NUF) countries pages which are written in national languages
{Countries section).

1.2. Your network’s page

As a network, the URBACT website is the most central and widely accessible online media at your disposal.
Please bear in mind the specificities of different web platforms (blogs etc.), in particular in terms of audience
before promoting your network’s activities somewhere else than on the website to avoid overlapping.
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* USER MANUAL FOR NETWORKS »

The content you produce (in-depth/fthematic articles, previews or reports of events, cities' profiles, short
videos, interviews, etc.) should be informative, clear and self-sustaining for non-URBACT readers. It has
to be written in good English and it is best to avoid jargon (refer to the URBACT guide “Writing about
integrated urban development” available on Sizsecamp, see below, for more detailed information). Good
content along with good photos is important in gaining the attention of URBACT readers and new potential

audiences interested in your topics.

Bear in mind that the Secretariat can promote your content on the editorialised pages (Homepage, thematic
or topic pages) if it's interesting for the wider audience and well written!

You have to update your network page once a month, meaning that you should create and/or upload any
type of content related to your network contents, activities and events. Do not hesitate to look at what other

networks do to get inspired!

Articles written by Programme Experts do not count as updates even though they are promoted on
your network’s page.

Maintaining a presence in social media will further help in commurizating aboul your network la the
URBACT and non-URBACT audiences. There are dedicated spaces on your network's page where you can
feature your social media accounts (see 3.2).
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2. LOGIN

From hito:/furbaci.euf, press Login (see below), then enter your userame and password, which are
provided by the Secretariat to at least one person per network and you will be required to change
your password. There is no need to create an account in order to access your network page back office.
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3. FIND AND MANAGE YOUR NETWORK
PAGE

3.1. Find your page on the website (FRONT OFFICE)

To access your network’s page from the homepage, press Networks and then choose from the list
according to the main theme of your network.
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3.2, Access your network page (BACK OFFICE)

Once you are duly logged in and you have reached your network page, press Edit. This is the entry to the
webpage back office, so you can then make amendments to your page.
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Another way to access the network page back office from the Homepage is to press Shortcuts > Find
content and type the name of your URBACT page in the Title box {(e.g. sub>urban) and choose Network in
the Type drop-down menu. Then press Apply. Click on the name of the page which appeared and you will

be redirected to it.
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3.3. Edit your network page

The image to the left is the first part of the structure of your network page. This particular information will
already be filled up and, unless you spot a mistake, it should not be modified.
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femove Edit

> Name: title of your network.

> Cne-liner: a short sentence explaining what your project is
about).

> Short name: acronyms used instead of the network’s
name when its tifle it is too long.

> Programme; whether your network is financed by the
URBACT Il programme (2014-2020) or if it was financed by
the previous programme.

> Status: whether your network is open (ongoing) or closed
(once the network’s activities are over).

> Type: type of vyour network, action planning,
implementation or transfer.

> Logo: logo of your network.

> Map: indicates all the cities which are partners in the
network.

——
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For the other fields, we expect you to fill up the necessary information and update it. Please keep in mind,
that certain fields might require changes overtime:
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> Short description: it_must be carefully filled since it is the overview of your network. The
introduction should provide a short and clear message, explaining the aims and challenges of the
network. It could as well expiain the value of the URBACT partnership for the project. This description
must include the words ‘Transfer network’ at some point and jt should not exceed 850 characters

(spaces included).

> Key dates: the key dates are arranged by year, so the specific dates (dd/mm) are not relevant and all
content from each year should be elaborate into sentences (in the field Name). You can add more years
by clicking in Add another item. You must add information about the network kick-off meeting and the
final event. You are also welcome to add other important events (e.g. transnational meetings that already

took place or are foreseen).
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Main theme ‘_W o
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> Main theme: this section relates to the URBACT themes (see more in section 3.1). Only one theme can
be selected and, even though we know that some networks might have a cross-cutting aspect, the main
theme should be seen as the entry point to your common objective or urban challenge. This section will
already be completed by the Secretariat and it should not be changed.

> Useful links: content relevant in the frame of your network, like social media, partners’ websites or other
online platforms related to the network. You do not necessarily need to fill up the description box,
nevertheless you must add a title, a URL (link to the page} and you must always tick the Open URL
in a New Window box. Should you have more than one relevant link, click on Add another item.

> Associated users: this field mentions the responsible for the access to the back office web page
{Communication’s Officer), the Lead Partner and the Lead Expert. All those people should have their
profile on the URBACT Community (see section 7.2), otherwise you cannot select them (as the image

above shows).
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It is possible to reorganise the order of the elements by clicking and dragging the cross to
the right
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The sections Shared from the web and Social media box must not be filled up, the links that are related to
both topics, should be add in the Useful links (page 11) instead. The same goes to the section Introduction

{page 10), which must remain empty.
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4. ADD CONTENT TO YOUR NETWORK

PAGE

To create new content, press Shortcuts > Add content and choose what kind of content you want to

create: article or event.

ﬂ Home

IAdd content

E Menu

Find contet

* Shortouts .l_ isabel.michielsen@stad.antwerpen.be
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. Update your page with any type of content at least once a month

4.1. Create an arficle/news

Onece you have clicked o Add content > Article, the following fields must be completed:

] Add coatent

fitte *

el Nenited g 150 chargeters, remalning: 150

Remnve it

R BAFR @ Rev W oaws
. - T — T T

’f www.urbact.eu

> Title: please refrain from using capital
letters.

> Image (see section 5. for advice and
instructions). please remember to always
include an image which well illustrates your
content (72 dpi, proportion 718 x 285), it
matters in terms of attractiveness of your
content which seems sloppy otherwise.
Visuals engage people emotionally and
they convey a first bit of information when
today readers are overloaded.

> Type: to categorise the content: article
or news.

»> Introduction: text presenting the article.

> Content: body of the article.
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For Introduction and Content, use the toolbar described below to customize the text. Formatting is important to

hierarchize infermation, identify titles, and highlight keywords.

D Easuan

rubber (“Remove Format”} before you edit the text so that formatting will show.

iﬂiﬁﬂlﬁ

mamove Format

If you intend to copy a pre-existing text in the box, first paste the text in your computer’s notepad (# Word) so that
all previous formatting will be gone. You can the copy it and paste it in the Content box. Make sure you use the
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If your article is too long and it has different sub-sections, you can create an Interactive index by selecting
the title of a subsection and click in the Anchor. Then write the index manually in the beginning of your
article and select the title of the sub-section, you will then click in the Link > Link type > Link by Anchor >

By anchor name. Repeat this task to each sub-section fitle.

If you wish to integrate a video - that is not to just add the link to it in the article but to have the video show

in the article itself - follow the procedure below, (such as Adobe Sparks or Iframes):

1. Make sure the video you want to integrate in your arficle is available on YouTube or a similar

supporting platform.

o
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2. Once on YouTube, click on the SHARE button, then on EMBED. The IFRAME code will show. You
can even choose from which minute/seconds you want the video to start if there are parts you think
are not relevani. Copy the IFRAME code.

Eqitard Wiiea

TN Show sopienied gans whes e idn fnishes
Show g4y eoeml;
il 15 stew iten e ot player acticns

7 ragts proscpe i mcrd mode. {

3. Go back to the URBACT website {(Create article tab). Click on Disable rich-text at the bottom of the
Confent box. Your text will show in codes, including the formatting. Place your cursor where you
want the video to appear in your text and paste the code.

Liontant ¥

& Nogrral

Enable rich-taxt

e
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Congant *
«p=TEST FOR VIDEQ. </p»<iframe width="560" hzisht="318" sre="hitps wve vovtube.com/embed
TZziAhg e fame ; ;

i n P

i1

7O NBERT A VIDED <>

Enable rich-text

4, Click on Enable rich-text and the video will appear as an IFRAME. You can then reposition the
video where you wish in the article.

rotent =

2 i Rsmms B OIN , fumal
‘s b et g e

M o§ i

TEST FOR VIDEC,

OV TO INSERT A VIDEC,

Crriiols 0% 1

5. In the front office, the video will show as below.

test

TEST FORVIDEQ.

HOW TO INSERT AVIDEO.
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> Networlc type your network name; it will then show. Select it so that the article is published on your
network page.
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> Revision information: by checking Create a new revision box, once the content is saved, a new
tab will appear. It will allow you to manage the different versions of your content {compare, revert or
delete 2 version).
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> Publishing option: if you wish to work further :::'s;::':ﬁﬂm 7] Published
on your article/news and save a draft version, |} - - e
uncheck the Published box. You will be able wmmnﬂs
to find your content in the back office using its | -
name (see section 3.2) | mrﬂ

> Save: Do not forget to Save the page when || fubleshed

you are satisfied with your work. N
| Save ' ‘ Previaw

4.2. Create an event

This is a great opportunity for URBACT and non-URBACT readers as well as urban practitioners to attend
and learn more about your network. Please only create an event on the website if the meeting you will be
holding is of interest for the wider public (transnational meetings for instance but not technical sessions such

as ULG).

To create an event, press Shortcuts > Add content > Event.

PR BT SRR )
Create Event ..

Tike®

Content limited to 130 characters, fafmainisg. 150 R
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[ E b
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E You have to follow the same procedure than for an article and fill in the same fields except for the DATES’
= one. [ndicate the days during which the event will take place (and not the date when you are publishing
the news). Only PUBLIC events should be created in the website.

[ 3
]
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When describing the event, outline what will occur, who will attend and the topics which will be touched
upon, Include a photo and an agenda. There is no need to fill in the Type category and Organizer fields.

Your event will then show on your calendar {see bottom of your network page), as well as on the URBACT
homepage one.
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5. UPLOAD AN IMAGE

It is important to pick a photo/an image that well illustrates your content. Please do not leave any content
without a proper illustration (72 dpi, proportion 718 x 285)

taitinn

Below are examples of platforms where
you can download pictures for free.
Make sure which uses you are allowed
to make of the pictures.

‘ . ‘. L
. s ¢

Ledadadt for noscomimeritel sonsn v Hars doals g

Lakzed for reuse with mosil sion

- Fotolia
- Stock. XCHNG

- Free pixels (no account needed for this
platform)

You can also use Google images but
make sure when you look out for pictures
that you click on Tools and then select
“Labeled for noncommercial reuse”

(see the image to the right).

r'lﬂ!‘lllllllllIIIIIIII!‘.“"KIIIII!’!IIIIIR!!IIIIIIIlll"lillIIIIIIIIIIIIIIIIIIIH

Keep in mind that there are two types of images’ files that you can upioad to the website:

- Website photo Library: it is the internal archive of the website images, like a collective photo bank, which
can be used to illustrate articles for instance. This is part of the website's back office and these images

shouid not be displayed in your network page.

- Picture section of the network page: this is your album of images, which will be showcased in your
network’s documents library. You should add infographics, sketches or very relevant photos from your
network's activities. Should you upload pictures, beware of not adding unappealing images, such meeting

photos.

To add a picture, press Shortcuts > Add content > Article/Event.
You then have two options, they are both further explained in the following sections (5.1 and 5.2).

3

ﬂ:'-;"-: ,‘;v’
.f‘a www.urbact.eu 20/ 39
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5.1. Using the Browse button

Press the Browse button under the Image section

Home » Add content

Create Article @ &

Titie *

Content limited to 150 characters, remaining: 150

I age
Browse

tntenduciion *

&
£l

B Y E

s

A pop-up window will open with two sections: Upload and Library

Lipload a new file *
f}ﬁ@jﬁs__s_g})ﬂ!ﬂ@igr_ gAucun fichier choisi-  Upinad -

Fies must be less than 500 K#
Blazed file types pog gif ipq ipeg

Mext

> Upload: choose a file, then click on Upload and press Next

u Please bear in mind that you can only upload images in .png .gif .jpg jpeg formats that do not exceed
70MB

AEARY,

| Mpinad

21,39
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A new page will come up where you need to make sure to change the name of your file appropriately
{including the topic of your picture, geographical indications: city and country, and the name of your

network).

?llll.lllllll'llll.lII!IIIIIII]IIIIIIIIIIIIIIIIIIIl'l‘-l'llII..I..H[I.IIIIII!IIIRI
. Properly filling in this field is important because other users of the website might look for a picture, in the
Library (photo bank} on the same theme as yours and can find it by entering keywords.

So always right what kind of photo it is, the geographical location and the name of the network. Good
examples of names include;

- Field visit — Vienna — sub.urban

- Elected representative — Riga — ACTive NGOs

In addition, in the Associated with field, indicate the name of your netwark,

Issssmzssanam N MERER v xS sB

zllllﬂlﬂﬂ'llluﬂ.!ﬂ!'lull

[ EERERENERERRERRRE AR AR RRRERRERNERTRERRERERNERREREEINARISRIRERERARERNRNERERERERNRRDNE]

S w— =
o Lo bk 67 £ e -
ar . X
Postad on
07042 0a 0858 w0205 ’ )
Formick. HrL 717 (108 29 40000 Y 1ttt BMOAL i VIFYSBAA-TH0 o 2T IS T LIAC 20 aE Irvis T, LA4UR DL 10 01 205 B2 OF P sutesrss 1o
Al Vet
—
TEAT Ui b el £ SIS IR, SSEFLR S e 3, N W TR MR SR £ b LT -4 Ot Mk R DG R TR G ¢ e
Tk Texs
Tithe besd 15 usced in ch2 e, ip whenmuser booors e mon. < over the BT, A 2 IR 807 M o3 e arshor {107 o B B LOnEh OF 30 g 20 0 e Lt ahil

st that the 470 peopie wha attended enjoyed the expesiente. )
hnowledge had hngroved after the Festhval! {3}

The Alt Text field is read by search engines, giving the image more
visibility. Therefore it is important to enter the relevant describing
keywaords for your image. Do not enter more than 10 words.

The Title Text field is the text that appears when a user hovers the
mouse over the image (see example to the right).

Dbt it whan wwm vy atmm]. Py 1 et iyl sew adant
A et LI rELY SR D (e T e o e e ol e il Teflocti

-" www.urbact.eu 29 [ 39
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Mt rmsce

HETWORY.

e amithar A

e
-_Hunenr f:'{'
MEETING

Date e

£g. 12085008 L., 433

Link

AL with 1

Langlage

IR

At

Frewais . Bave

Select Type > Image and Format > JPEG

In the block Network, write the name of your
natwork

If tha image has authorship rights, please
indicate the Link and the Author.

Then press Save

Your image will then be displayed as below and will automatically appear on the left hand comer of your
contant in the front office of the website.

e EEI A

Tithe *

Content limited to } 56 characters, remaining 55

troage
B i O
ot Pl Y

PELHA LT

Remove

LERCE R

Tyse

Samcle -

Edit Article A city fighting climate change

E;Ey_ﬁymng rlmate change: Huw &ms got itz cuzans

Back office

stnabenssingg s diaratcin
" —“"_‘- Civic participatinn can ba ay|
I' 5 ;_' power, once unleashed, can |

: "_ However, i s Clear that we f

' between politicians ant the

ity authorities af lesst, that
thie legitimacy of thelr agtion
the focal feval, whers new tr
government aré bedt createy

Consequently, cities across Digope are explpring new ways (o)
processes. Within URBACT, many clties, including Amersfoort 4
Current networks such as CHAMGE! are afso exploring this the

response to the recent URBACT call for good praciices. Front Ofﬁce

inapcalin: rebation to the dlime
anenlan’ - s e totieering

Ftastad B sertivyssi France, Nantes has a population of 630,04
Hafeglag a vy atdon dur 3 healthy work-iife balancs, i was thel
{aie oo Cirpen Uapllad, in 2017, An active member of Energy o
o il vtz by S0 by 2030 (compared to a X003 ba
enary in the same taframe.

www.urbact.eu
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You can also select an existing photo, from our photo bank, by clicking in Library instead of Upload,

> Library: choose an image that has already been uploaded on the website. You can search for your
content via File name, Type, Sort by section or Order and then press Submit

File name Type Sort by Order

cAnys v Uploaddate ¥, Desc ¥.  SOEN

b i g

Participant

Food gharing | F432733801 jp
oy i |

workshap i with journs} 4 <

A putlcblnm S Ll Bl meal ihs
with jmnmk 2 ; =ik e

wnh pumtl k] 1 o i

i Farticipant &‘E

W
R

i
i
WA iy {
H

! pan—!l‘“ 7 !

FARIT VB Jp i . &
FEST hosan g beenl @ mage fandi

Phwti

FEST_mext the |
Lo I

L cities 77
i

next » last»

St

Your image will then be displayed as shown before.

‘.“' www.urbact.eu 24/ 39
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5.2. Using the Add media button

In the Content box, place cursor where you want the image to appear then click on the Add media button

(image icon).

Coatent *

_ Registrations reached capacity a month before the event and from the onsite buzz and forrmal feednb
people who attended enjoyed ihe experience. What Is more, 91% declared that thelr general knowlg

(1

leme i wane image fo appear

| But what do we know about how citles Jeam? How did we adapt the URBACT approach to the Festiv.
factors? Here are some post event reflections on what rakes a City Festival work,

A pop-up window will come up with three sections this time: Upload, Web and Library.

File name Pe  somby

B - ¥

i W 1 ot HE e T b
5 UL [N T

e | = o W l;‘ L,
. EERSET . seeme N Y
Hips meed b | G RIGA Groww ] 14BETIEOSNM L hve
woP . B &

Ehhisn : Fhote  § 0 { FEST badipes

! | m ;.,Mhh’ﬁ;! L i

A - i - ira -

g s ':}‘-'ﬁ“i I et e e S i
AR -~ -_!h"—:__.-- & L ChpPastiual WALKSHOP Elactric Yehichn Sprachk for n Mew Fatuts |
e A vl W)

! i : i Veiabnal e A
L Fest_biga ¢ fextivabbones, | | EEST mabubion | — L oo oo o
i . i i wmrmpn s e - HH AR TE - onwivehi~en.pdf ;
§ magnr T mowimng it | s—dpnir 1 LI ]

g — — ] TEE— S M NS
i rm———— i — e
3 Hued Finad Gapitvbook « The Roud to Suteess - Integrated Management of Histori Towns i —
L oSS S S S — s o e e s 2 ettt k) S g e e
. esimec_coaking |
¢ _kexxon slkajp
o f
] " -
HWerd Final Pollcy Secommendations - fhe Road to 2 Yy ] of foerns

The Upload and Library sections have already been described.
The Web section will not be of use for you.

When choosing your image, a pop-up window will opan.
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T mieckiing RIGA Croap Frote ™. [

You will then have the possibility to choose the way the image is displayed as well as entering further

information on the picture.

OPTIONS

Display 45 | Dofaut  *

Chimnag o[
{ Teager
i Praview
Alt Text| WYSWYG

vigd by goresn raadkrs, S62r0o 203 e 300 whan te Lnane carnntbe Daded. Oy wdeing sltteat s aeproes acias it Ly oo search

Title Text

Title tast s usa 4 in Hhe topl e o usar hovers their mausse over Lz paana. Adciesg vile ot mal a5 b eas o 1o understand w1s cone.t of an image and
freore res salshbn

Cities

Chrear Pass wuainkee
[

In the Options, choose Display as WYSIWYG (What you see is what you get).

Once you have entered all the information and pressed Submit, the image will be embedded in your text

(see next page).

7. www.urbact.eu 26 1 39
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c“ntem . . L B . . .

o e e = : p— ——

IR - L Y Ewha Moy .
L2 B R

site buzz and formal foapnlart wee nan

You can then click right to access the Image Properties.

Comisng =

BIUE ZEE«a~BAFPARS twemd Foe T3 a3

] L imags Properdies

e E——

balw w lieg
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> The size can be changed by modifying the Width and Height fields.
In order for you not to lose the ratio of the image’s proportions, make sure the lock sign is CLOSED.

Image Properties -

imagetnfa  Link  Agvanced

UL [ ee— o T
tipfibact evisitesidefavitilesimediariga_1 jpg |
Alternative Tedd d
[ = ]

ST R A R e
ipsum dolor sit amet, consectstuer adipiscing efit. M

vBpace | lfeugiat consecuat diam. Mascenas melus. Vivamus

I i i {purus, cursus 4, commoedo nen, facilisis vitag, nulta.

Alignment . { ldicturn facinia tortor. Nune iaculis, nish pﬂn jaculis a ™

{ | ; § UL R e »
ik

{enotsets ¥

> To add a border to your image, insert a number that corresponds to the degree of shading you wish to
obtain. Increasing numbers will lead to thicker borders.

Image Properties ®

Image info  Link  Advanced

URL
hilp Foshact swisnesidefaultMesimediahigs, e

Alternatrie Teai

width
90

ipsum dolor sit amet consecteluer adipiscing elit. M
il i feugiat corsequat diam. Mascenas metus. Vivamus
Lo fromsam purus, cursus a, commodo non, facilizis vitag, nulla,

A@Qnment i Ainbiimn Imaimis sovbewe Blovemc imcrcbin mibie wmi lmanlic s
‘apotset= v |- i

(k. - W ""él
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> To add spacing between your picture and your text, insert numbers as shown below.

Image Properties

Iraage infe Link, Adgwanced

URL

Alternattve Ted

Fresiaye

Width

_I‘lﬂp;ﬁurbat%_euf%lieﬂiﬁef&u§£=‘ﬁl€'§!rne?ﬂ';a!u=_na_‘:,jpg ]

300 ;

Height °
124 1

Border
3
HSpace
5

vapace
R
Atlgnment

i o

aar it aref, cond
teugial conseguat diar MasceRzs metus, Vivamus
CUrgHS 4 LORIMGS nan. Tacilisis vike. nulla. Aenea

¢ | . : > ]

eoletier atipiscing it M

{<notset- ¥ |

OK

R

See below the difference between an image with and an image without spacing.

4 balanced programme of rich =

fromsagial
mobility ai
choices, to
fearning lourney through the Festival.

A balanced programme of rich a

l

i The choig
| different
PR socialiss
: featiring
ranging fi
making. 5
participa
interest

7L www.urbact.eu
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> You can also choose where to align your picture, either on the right or on the left side of your text.

imaye Properties L
wmagokic  Link  Adeanced

R,
feiuiteitstas ud uns veas el

N

Once you are done with the settings, press CK,

h-" i

. www.urbact.eu 30/ 3%
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6. UPLOAD A DOCUMENT

To upload a document on the website, press Shortcuts > Add content > Article/Event

Then in the Content box, press the Add media button. A pop-up window will open in the Upload section.

Choose a file, then click on Upload and press Next.

Content ™

B I Yy ==

@ P G sowce (@ [@ X, Fomat < | Siviss - i e

You then have to decide on the Destination of your file: choose Public local files served by the
webserver for it to be found by unauthenticated visitors. Then press Next

Destination *
I B Public local fiies farvest by She mn:r.l

Privase local Miles served by Drugal

11 4

User information

. Workfiow | Latdves Fp, B R i .
sdosbet =

Postad on
AT 090328 +0200 ) o N
S22 LS 000" ThE At £k LYY -MA-0D snd i

Ale Texe
——

_f‘"‘,ﬂ"ﬂﬂ!ﬂ‘e LRE 15 us0G By SRR TS, STk saggos, ol v

Tinthe Tesck.
—

Tide TxUAS US4 Ak TS Lo o arfr e oS L@ 15 2inke s A TR 0 2. AC 13 Tt I it ikt 10 TersERe 1 o)

e ]

RS

L e ]

Then fill in the same fields than for images. Add
a short introduction to present your document.
Makes sure the name you give to your document
is clear and easy to use and look for and
understandable for a non-URBACT audience;
mention the name of your network, the type of
document, the location if needed. Eg. sub>urban
— transnational meeting brief — Antwerp

www.urbact.eu 31/ 3%
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Elll.ll'llll!kll’lllllIlllll!ll.llllllllllllllllllﬂllIlllll!l!ﬁ!llll!llll#ﬂlllllﬂlg

« Just like with the uploaded images, it remains very important to name your file accordingly to the

Toma

vg. 12rekRTT

nature of this document. That is to say, name it with a proper title, geographical location and the
name of the network, if necessary.

(SRR EENAETERERAERERERNRREREREREREEINEERERERREIARERRERRIERRERRRRARERRERSRERSRERENSERENDR]

> Source: you should indicate if it is a document that was produced by
your network.

> Category: select if it is a baseline study, a thematic paper, a case study
efc.

> Type: select if it is a document, a presentation or other.

> Date: if your document is linked to a mesting, fill in the date and time of
the seminar.

> Language: indicate the language in which the document is written.

> Format: select what is the format of the document, .pdf, .dac, .ppt etc.

Ac) e pbher tsm

LFi=1

SHoa o woighrs.

EHIIIIQ

Then press Save.

FRGENAERIEREANE RN AN EEINAEEENENARERREARDA NI ENANRNNENEESENEERRMRNIIDNORIGRARNERN

Remember to select your network, otherwise the document will not appear in your library!

(ST T RN AR RN RN N R RN RRERANERRIRARRNRRRRRERIERERESRELERENENNNNIERELENENEY]

k|
]
&

Your document has been uploaded; you can leave the page without creating an article or an event.

www.urbact.eu
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7. MANAGE YOUR PERSONAL PROFILE ON

THE WEBSITE

The technical team has created accounts for the Lead Partner communication officer and the Lead Expert,
for them to use the website, make amendments to their network page and to their profile in the URBACT

Community. If someone else requires an account, please send us their contact details.

There are two types of profiles on the website: one to access the back office (Account section) and one
which is public as it is features in the URBACT Community. The two profiles are independent.

Once you reached the homepage, click on My account.

ir teogle e moduies K, Confguration ol Fopure R e

FESNT Radighs VRBAN TDPICS

L H {-,m_ l

You will then be directed to your profile (front office), click on Edit to update your information.

S T IRTRYIN! [P P—

] wpeks

NETWORKS COUNTRY NEWS & EVENTS LIBRARY URBACT GOOI PRACTICES

1550
of IJHILI\I

Integrated Urban Development

St nd Shes . He

“ooman

AACRITURBACT

L Vi

LE [ ;.

EURTPELT UNION

SURBACT [l Lo

T P g v Deeivpment Fuad
T

URBAN TOPICS METWAORKS COUNTRY MEWS & EVENTS. LIBRARY URBACT GOOD PRACTICES

Mark DUNCANM

Lead Partner - Smartimpact Metwork

tAark iz the Lead Pariner for the Smartimpact URBACY I Network ang. .
previous iecd partner for C51 Eurorz URBACT B notwork, M.sk has wored 1 nfo rmations
on regeneration focused UK and Evropesn furd e pregranimas sit.ce 1999 In
Manchester and the NW of England. Mark has experiene of developin g and
tivering Financhal Instrusnent fhoan) funds with &th EC and L Member Matlorality: British

State rescurce:s ang was pard of a smali tean, alongs]del}sﬁardnawm . ——
wiole theid for meemblumment o‘f lhu NW i:vsgfurs Fund, oo u rim Residenvecountry.  Lnikar Kirzden

PR

"'_' www.urbact.eu
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7.1. Edit your personal information

AT & ATV

HEHEH A F ]

Firsk Mame ¥
Mak

£ EMAR, SETVINGS

'} Pgintaxt amai oty
CRgts: Hhis opsen B you g0 100t wish (o rerec e 2mai meisanes with grashs and siyles.

Lhsername ° Sp—
mynean ;
Attetd n ot S0 POKIES, Nyfiens, ADOSTrOpEe:. and endaridaies,

SLALEY ATC A0t D, pUnCivalon i B

it ey
aferve

TR P i =y ¢ il nh oF Pagsine s ROGuest new pRSIwd.

E-ma midress ¥
‘ALdunCaTEmal.cotn ;
& vatiz m-mail cgidrass, Al & emens from the systerr will be sent 1o 4t adcrers. The e-mal 3ddresy is not made putttic #nc will ©5

A —

o thenge the et User passvend, enrer the pew pasmwrd in both feids,

EERE

57 Delere preture
Check this box to Beiere your CuTEnt DICTe.

j Aucun fichier sélscLonné

Furad VBl e £F periuee Brigeds Parplr Mo pixeis e staiod do .

| EumpaPais. Twrsds, 14 Manch 2015~ 120250100 e
This Site vl bl gy

saing ihos WA TONE.

b Spiect fhe Basiad Lol tiene and e 2one. Cates and taws &

= META TAGY
Sava Caned et

. www.urbact.eu 34/ 39

Once you have accessed the back office of
your account, you will be able to:

- Modify your name.

- Change your username.

- Change your password.

- Update contact details (e-mail).
- Upload a profile picture.

- And other specific seftings.

It is not required for you to set the Meta
tags,
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7.2. Edit your URBACT Community public profile

You can fill further information about yourself in the Main profile secticn to create a profile in the
Community, which is available at: fittps://urbact.eu/community

In order to do so, you have to click on Main profile in the top right (see the image below):

Az whisted
mduncan o

Hame ©
oungas

e R
mduncan, e

Naanp *
by

der -

Phetwenls psizion *

L Parins - S1 ke pact Hek k.

Hography ©

oot

Mok 16 P LAsoFariasr a1 e Siart -zt URBAST 1 4aber i ard prsa wa
oo tmas wih 5 EG ansiUK Bemde Tls 5ediocs g was pari of & 5my
W AR TRl of T Greater Mt RHAZOELF prosramme waid

Swrnd i

Sowcinl media fieehaosk

Sha s G v DS U 32 FRARECE K £ T

Sodial media twitter
Tike

The ik E2E 15 5 G 1 2B Chiuadiol pads e

Socisl wdsa Wikwdin

Arene of axpertice
B ltesesed Lieon Qeve g rent

Apart from your name, first name, network position, biography,
nationality, residence country, you can also add information about
your profession and institution, the languages you speak, your
social media presence, as well as your areas and topics of
expertise.

rlII‘l!lﬁllll!ﬁ!ll!lllllllllll!llllllllll!]ﬂlllll!

Your biography will appear at the centre of your profile page
(see page 33). It is thus important to carefully write,

proofread and update it.

a
g
"
L]
®
.
-

To better clarify which fields you work with, you are welcome to select
your Areas of expertise by ticking one or more URBACT themes. In
addition, you can select more specific sub-themes by selecting the
Topics (to select more than one, you must hold Ctrl as you click
in the different topics).
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Once your profile is added to the URBACT Community, your personal page will feature all of tha articles you
have written (see below).

Informations

Hationz 1y Gritith
Reslfiag oz churdry:  United Kingdorm
Lesguapa hinct

Area of expertise R AT
S E-mall: ™ '
e eectnon | [ o | Ui Kingdom n
[ 4 ]in
Latest articles

ARTICLE | b4 March 2019

Aninvitation to Madrid

Exldy Adacs, Si¥ Acdvixer and URBACT Pragramneie Eupest sxrs Torape's L lies e
o3 i i parbriat peatn. dern ch Srensrich

ARULES 2320w 2018
Traaster nabwe rks, an UREACT Learning Lab to buitd caputity antt
o £

dop areass burngs

To reach the URBACT Community pages, scroll down on the homepage and press the FIND PEOPLE &
EXPERTS button.

FCOROMY
Atresh approach to housing:
Posnan's innovative olter (o keep
 young talent inthe city
: mcnyafm‘mrva.’-mw.awm.ns

LM&MD-
6 £ rpbin Friymdst.
f-vents
The Community is classified by alphabetical order:
URBACT Community
Fiot R Sy Ji4 A i T A e i wend) g Theratic
m o o Fniraed 1hm aCY v mpmybers of
C—«l;‘-‘l.'whw-‘.».m- b - - IVW S izl
™oy Cddy i Ratfaste
ﬁ Adarris W Bartato
Progr e Dot - BragE Casted wulir 30 eban ¥ -
sy v b LA
F Agres Y basrcelline
EFY Bohdryey & Bonneau
et Faprt Lt Enpirt
2 0 I
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8. FOCUS ON CITY PAGES

City pages give an overview of the city involvement in URBACT. They are not linked to a single network
partner, but aggregate all the articles and documents published on the website about the specific city. The
pages are not curated, but automatically gather contents from the website in which the city is tagged.

City pages are named after the city, not after an organisation, even though the legal/official partner in a
network is an organisation.

This is also linked to the fact that a city can be involved in numerous networks through different
organisations or city districts. These organisations or districts can however be mentioned on the page, in the
Introduction section (left column, see below). In addition, please keep in mind that once cities can be
linked to different networks, with a wide range of urban fopics, it remains important to leave this description

broad to a certain extend.

It is important to keep this page updated, so please read it carefully and, if necessary, send amendmanis
to cominunication@urbact. eu (this also incluJes sending or updating the main piciure of this page).

BARCELONA

The tapiual of 1he sutonamous region of Catases, ard Spain's second chty, Rircelonals
theiving city of §.6 miglon, The Gty offers 3 combination of srchiteCturat herilage sl
surteatfil rmpen ution, The Ramblag area of shops and restavesuts, the ol Gotlie
Crusrter and 10 disnctive Bangdmarks created by Gawd! and the Art Nawveu srehituets
of the sariy il ountury have mads Harcelona 2 centre for cultural Purises. Howpese, 3
program of utban redsssioprent har begas with the preparaiions for the 1992 Obmpic
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« USER MANUAL FOR NETWORKS »

9. END OF PHASE Il ACTIVITIES

9.1. Network’s results section

Once the activities of your network will have come to an end (in December 2020), some specific
maodifications must be done in the back office of your network page:

Status (page 9): must be switched from Ongoing to Closed.

Short description (page 10} if necessary, update the description of your activities (850 characters
maxirmum).

- Key dates (page 10): make sure all the relevant dates, including the network’s final event.

In addition, it is time to fill up the following content in the Network closed tab at the end of the page:

> Video OR Image: one of those
— =t elements will be used as the
banner of your network page. You
= can either use a URL from a
e YouTube in the Video bloc, in
= — e _¢ English or with subtitles and
i ".”T‘_ “;n"""' prefer ably one that gives an
- overview of the network.
wens v’ Alternatively, you can add a photo,
e -} by using the Image Browse as
w:::_ ‘ e -1 long as it is a 72 dpi image with
et et i the following proportions: 718 x
I 285. .

e

Eai<s the VouTubte Ut virkd 15 2

Prr e b -

AL roa e

Fused

by S 1
g

(= e m A ses  ws  =aa 1 > Network outputs: to add the
main results from vyour network
activiies (from one to five
outputs). For each one of them
(e.g. PDF file, online platform,
series of videos on YouTube,
o ., among others) a URL and a title
(Text) must be duly filled up.

> Get in touch: the Text box should have the contact information from the Lead Partner - no need to add
any personal information - just the name of the city department that was involvad in the network and the
address from the city hall is more than enough. Should the Lead Partner have a generic e-mail, it can be

added to the Mail box, but this is not mandatory.
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Driving change for
watier citles

CONTACTS
For any questions regarding technical issues, please contact:
web-suppori@urbact.au

For other questions:

communication@urbact.eu
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